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1. OVERVIEW  

The 3080IPG-HD is a complete high density hardware solution for 3G/HD/SD SDI video to IP conversion, 
and vice-versa. As more providers are delivering contribution and distribution quality video over IP 
networks, the 3080IPG-HD is capable of effectively bridging the traditional SDI video world with IP 
networks. 
 
Controlled by the industry leading VistaLINK® PRO, the 3080IPG-HD offers signal providers the capability 
to encapsulate any HD SDI video payloads to a unicast or multicast standardized IP stream. The 
3080IPG-HD is also capable of receiving IP streams and de-encapsulating to 3G/HD/SD SDI.  
 
The 3080IPG-HD supports several forms of redundancy scenarios in accordance to today’s broadcasters 
needs. With these features, the 3080IPG-HD can be used in conjunction with any other Evertz equipments 
like Audio/Video Routers, and Multiplexers in a fully redundant System. The failover features are 
implemented when a link loss, or a UDP loss occur. 
 
Coupled with the 3080IPX 640Gb/s Multicast tunnels switching fabric, in LAN applications the 3080IPG-
HD allows users to build a large scale distributed routing solution over 10GE with the benefits of direct 
conversion to optics and reduction in cable count by a factor of 6x. 
 
The 3080IPG-HD platform provides 3G/HD/SD SDI inputs and outputs over DIN connectors and network 
interfaces via SFP+ cages each capable of 10GigE. 
 
The 3080IPG-HD occupies two card slots and can be housed in a 3RU frame which will hold up to 2 
modules, 6RU frame which will hold up to 7 modules, and 3000/3700 frame which will hold up to 3 
modules.  
 
Applications include:   
 

• Bridging traditional coaxial networks with emerging video over 10GigE IP networks 
• 3G/HD/SD SDI to IP encapsulation 
• IP  to 3G/HD/SD SDI de-encapsulation 
• UDP or RTP input/output 
• IP network with QoS, VLAN and DiffServ   
• 10GbE Port, Device Redundancy  

 
Features: 
 

• Fully integrated with the Industry leading Evertz VistaLINK®  Pro NMS system 
• 2x 10GigE IP Ports for 3080IPG-HD6-IP10GE or 4x 10GigE IP ports for 3080IPG-HD12-IP10GE 
• 12xSDI Input and 12xSDI Output Ports for 3080IPG-HD12-IP10GE (6 for the 3080IPG-HD6-

IP10GE) 
• 3G/HD/SD SDI to IP conversion, and vise versa 
• Direct module control via SNMP (separate IP port) 
• Auto fail-over to the redundant incoming Transport Streams over IP 
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Figure 1-1: 3080IPG-HD Block Diagram 
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2. SPECIFICATIONS 

2.1. INPUTS AND OUTPUS 

• 6xSDI or 12xSDI SD, HD, or 3G input  
• 6xSDI or 12xSDI SD, HD, or 3G output  
• Min SDI input bitrate 270Mb/s 
• Max SDI input bitrate 2.97Gb/s 
• 2xSFP+ (3080IPG-HD6-IP10GE), or 4xSFP+ (3080IPG-HD12-IP10GE) 10GigE I/O for transport 

stream over IP 
 

2.2. ENCAPSULATION PARAMETERS 

• IP encapsulation for each SDI input: 
o MAC 802.3>IPV4>UDP>RTP>Transport Stream  (RTP can be turned on and off) 
o 7 Transport Stream packets per IP frame 

• IP address (IP, Subnet mask, Gateway) for the source 
• IP address for the destination (Unicast and Multicast) 
• Selection of the source port and destination port 
• Set Local MAC address of the equipment 

 

2.3. DE-ENCAPSULATION PARAMETERS 

• Join Multicast by providing correct messaging using IGMP V2/V3 (SSM Support) 
• Selection of the UDP Ports 

 

2.4. TSM LITE MONITORED PARAMETERS 

• Total Bitrate 
• Null Packet Bitrate 
• TS_sync_loss 
• Continuity count error 

 

2.5. PHYSICAL (MAXIMUM NUMBER OF CARDS) 

 3000FR:  3 
 3700FR:  3 

EMX3:  2 
EMX6:  7 
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3. INSTALLATION 

3.1. REAR PLATE DESCRIPTION 

The 3080IPG-HD comes standard with a companion +6RU rear plate. Figure 2-1 provides an illustration of 
the 3080IPG-HD rear plate. 
 

 
Figure 3-1: Rear Plate for 3080IPG-HD12-IP10GE 



EMX3/EMX6/3000FR/3700 MultiFrame Manual 
3080IPG-HD High Density IP Gateway 

INSTALLATION Revision 1.0 Page - 5 

3.1.1. Video Connections 
SDI IN: Each BNC connector input is compatible with SMPTE SDI standards.   
 
SDI OUT: Each BNC connector output is compatible with SMPTE SDI standards  
 
3.1.2. Frame Controller Ethernet Connection 
The IPG Series uses 10Base-T (10 Mbps), 100Base-TX (100 Mbps) or Gigabit (1Gbps) twisted pair 
Ethernet cabling systems.  When connecting for 10Base-T systems, category 3, 4, or 5 UTP cable as well 
as EIA/TIA – 568 100Ω STP cable may be used.  When connecting for 100Base-TX systems, category 5 
UTP cable is required.  The cable must be “straight-through” with an RJ-45 connector at each end.  
Establish the network connection by plugging one end of the cable into the RJ-45 receptacle of the Frame 
Controller of the chassis and the other end into a port of the supporting hub. 
 
The straight-through RJ-45 cable can be purchased or can be constructed using the pin-out information in 
Table 2-1.  A colour coded wiring table is provided in Table 2-1 for the current RJ-45 standards (AT&T 
258A or EIA/TIA 258B colour coding shown). Also refer to the notes following the table for additional 
wiring guide information.  
 

Pin  
1 

 

Pin # Signal EIA/TIA 568A AT&T 258A or 
EIA/TIA 568B 

10BaseT 
or 100BaseT 

1 Transmit + White/Green White/Orange X 
2 Transmit – Green/White or White Orange/White or Orange X 
3 Receive + White/Orange White/Green X 
4 N/A Blue/White or Blue Blue/White or Blue Not used (required) 
5 N/A White/Blue White/Blue Not used (required) 
6 Receive – Orange/White or Orange Green/White or Green X 
7 N/A White/Brown White/Brown Not used (required) 
8 N/A Brown/White or Brown Brown/White or Brown Not used (required) 

Table 3-1: Standard RJ-45 Wiring Colour Codes 
 
Note the following cabling information for this wiring guide: 
 
• Only two pairs of wires are used in the 8-pin RJ-45 connector to carry Ethernet signals. 
• Even though pins 4, 5, 7 and 8 are not used, it is mandatory that they be present in the cable. 
• 10BaseT and 100BaseT use the same pins (a crossover cable made for one will also work with the 

other). 
• Pairs may be solid colors and not have a stripe. 
• Category 5 cable must use Category 5 rated connectors. 
 
The maximum cable run between the router and the supporting hub is 300 ft (90 m).  The maximum 
combined cable run between any two end points (i.e. router and PC/laptop via network hub) is 675 feet 
(205 m). 
 
Devices on the Ethernet network continually monitor the receive data path for activity as a means of 
checking that the link is working correctly.  When the network is idle, the devices also send a link test 
signal to one another to verify link integrity.  The rear panel is fitted with two LEDs to monitor the Ethernet 
connection.  
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1000: This Amber LED is ON when a 100Base-TX link is last detected.  The LED is OFF when a 
10Base-T link is last detected (the LINK LED is ON). Upon power-up the LED is OFF as the 
last detected rate is not known and therefore defaults to the 10Base-T state until rate 
detection is completed.  

 
LN/ACT: This dual purpose Green LED indicates that the card has established a valid linkage to its 

hub, and whether the module is sending or receiving data.  This LED will be ON when the 
module has established a good link to its supporting hub.  This gives you a good indication 
that the segment is wired correctly. The LED will BLINK when the module is sending or 
receiving data. The LED will be OFF if there is no valid connection.  

 

3.2. HARDWARE INSTALLATION 
To successfully install the 3080IPG-HD, the following is required: 
 

1. Unused IP address on the network or a DHCP server. 
2. Evertz serial cable. 
3. VistaLINK® PRO Server IP address. 

 
Before handling the card it is important to minimize the potential effects of static electricity. It is therefore 
recommended that an ESD strap be worn.   
 
Locate on the chassis 2 adjacent vacant slots. Unpack the 3080IPG-HD and separate the rear panel from 
the main card. Locate on the rear of the rack the two slots and remove the blanking panels. Insert the rear 
panel into the back of the chassis and secure using the four screws provided.  
 

 
Figure 3-2: Serial Connection for 3080IPT-HD 



EMX3/EMX6/3000FR/3700 MultiFrame Manual 
3080IPG-HD High Density IP Gateway 

INSTALLATION Revision 1.0 Page - 7 

Before inserting the front card, connect the serial cable to the board using the serial cable provided (See 
Fig. 3-2 for reference). Now insert the 3080IPG-HD card into the corresponding front slots ensuring the 
card lines up with the slot runners on the bottom and the top of the chassis. Push the card firmly into the 
slot ensuring that when it mates with the rear card, and it has been firmly pushed into a seated position. 
Do not connect any cables to the rear card (failure to do this could cause unwanted network issues) until 
the initial configuration has been completed. 
 
Connect the 9-pin d-type end of the serial cable to the serial port of your computer. Open a Terminal 
session and configure the port for the following configuration:  
 
 
 
 
 
 
 

 
Click OK to apply these settings and press the return key. The session should respond with the 3080IPG-
HD Main Menu (see Fig. 3-3):  
 

 
Figure 3-3: 3080IPG-HD TeraTerm Main Menu 

 
(1) Network Configuration 
This sub-menu enables the user to configure the control network settings for the card. Configuring this 
sub-menu allows the user to access the card through the VistaLINK® PRO Client interface. 
 
(2) SNMP Configuration 
This sub-menu enables the user to configure the Simple Network Management Protocol settings. In this 
menu you can set or remove the SNMP trap IP address and the SNMP Read and Set community strings. 
 
(3) Data Network Configuration  
This sub-menu is used to configure the data port settings. This configuration is also performed via 
VistaLINK® PRO will not be covered in this section. 
 
 
 

Bits per second 115200 
Data Bits 8 
Parity None 
Stop Bits 2 
Flow Control None 
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(4) Input/Output Configuration 
This sub-menu is used to configure and monitor the Unicast/Multicast IP input/output streams, as well as 
the SDI input streams. This configuration is also performed via the VistaLINK® PRO client and will not be 
covered in this section.  
 
(5) Trace – Engineering Only 
This menu is for Evertz personnel only. You may be requested to access and execute options within this 
menu when seeking technical support from Evertz. Guidance will be given should this be required. 
 
(6) Engineering/Debug 
This menu is for Evertz personnel only. You may be requested to access and execute options within this 
menu when seeking technical support from Evertz. Guidance will be given should this be required. 
 
Before it is possible to configure the card via VistaLINK® PRO it is first necessary to configure the initial 
basic network settings via the serial cable.  Refer to section 3.3. 
 

3.3. CONFIGURING THE BASIC NETWORK SETTINGS 
Select option (1) Network Configuration, the Network Configuration menu will be displayed as shown in 
Fig 3-3. If you prefer to use DHCP then you may select option (5) Set DHCP/Hotswap mode, and then 
continue from step 4: 
 

1. Select option (1) Set IP Address and configure the IP address for the 3080IPG-HD ensuring that 
the IP address is not already in use on the network.  
 

2. Now select option (2) Set Netmask and configure the correct subnet mask for your network.  
 

3. If required also configure option (3) Set Gateway and (4) Set Broadcast Address. 
 

4. Exit from the Network Configuration menu using (S) Save and Exit, NOT (X) Exit. 
 

 
Figure 3-4: Network Configuration for 3080IPG-HD 
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From the Main Menu, select option (2) SNMP Configuration. Select option (1) Set IP Address and enter 
the IP address of your VistaLINK® PRO Server.  Exit using option (S) Save and Exit, now extract the card 
from the rack, remove the serial cable and re-insert it. 
 
 

 
NOTE: These changes will not take effect unless the 3080IPG-HD is power cycled. 

 
You have now completed the minimum necessary network configuration and can connect the cables to the 
rear card when ready. 
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4. CARD CONFIGURATION 

4.1. CONNECTING TO VLPRO 

This chapter assumes that the VistaLINK® PRO server and client are already configured for your network 
and you have basic knowledge of the VistaLINK® PRO interface. It also assumes that the user or network 
administrator has already added the appropriate jar file to the server, and both the client and server 
applications have been restarted.  Please refer to the VistaLINK® PRO manual for instruction on how to 
load a jar file.  If you are the network administrator refer to section 5.1 for information on updating the 
VistaLINK® PRO Server Jar File. 
 
Open VistaLINK® PRO and click on the refresh tree icon. Expand the hardware tree by clicking on the “+” 
button. Your card should appear as a newly listed device with its IP address used to configure the card in 
Step 3.2 above. It may take up to a minute to appear while the card and switch negotiate network settings 
(this can be verified directly on the switch if necessary). Please note that the 3080IPG-HD will identify two 
items under the IP address in the navigation tree: Input to IP and IP to Output sub menu. Select the “+” 
button beside “Inputs to IP” to expand the IP output list. Select the “+” button beside the “IP to Outputs” 
option to expand the IP input list. Ensure that these tabs are present to confirm that the proper jar file is 
loaded. The user will be required to individually select each item to configure the appropriate function. 
 
 

 

Note: If after a couple of minutes the card has still not appeared, try selecting Add 
Agent from the Tree> Add/Update Agent menu. Enter the IP address and select 
OK.  The card should now be listed and will remain grayed out for a moment while 
VistaLINK® PRO finds the card and confirms its configuration. 

 
 
Please consult your network administrator if you continue to have problems connecting the card with 
VistaLINK® PRO, alternatively contact Evertz Microsystems Ltd. or your authorized reseller for technical 
support.  
Right click the IP address or the sub-modules of the 3080IPG-HD to access and configure their 
parameters. Select “View Configuration” from one of the modules available (Input to IP, or IP to Output). 
The configuration page will open, enabling the user to toggle the configuration tabs in order to configure 
the parameters of the 3080IPG-HD. See sections 4.2 to 4.4 to provide an explanation of the functions and 
features of the 3080IPG-HD card. 
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4.2. MAIN CONTROL TAB 

Right click the IP address and select “View Configuration” to open the configuration dialogue box (see Fig. 
4-1) and set Ports 1, 2, 3, and 4’s Data Port IP parameters. 
 

 
Figure 4-1: Ethernet Data Port Parameters 

 

 

Note: The physical SDI input/output DIN connectors 1-6 are used with physical IP 
slots “SFP1 & SFP2”, while SDI DIN connectors 7-12 are used with IP slots “SFP3 
& SFP4”. These name assignments are shown on the rear-plate. 

 
 
Selecting the tab entitled “Ethernet Monitor Main/Redundant” (see Fig. 4-2) shows the 10GigE link status 
as well as multiple monitoring options for each individual port: 
 

• Received/Transmitted Bandwidth:  The incoming/outgoing transport stream bandwidth on the 
specific port 
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• Error-Free Frames Received/Transmitted: The total number of error-free frames 
received/transmitted from the transport stream. 

 
• Erroneous Frames Received/Transmitted:  The total number of frames with errors 

received/transmitted from the transport stream. 
 

• Broadcast Frames Received/Transmitted: The total number of broadcast frames 
received/transmitted on the transport stream. 

 
• Unicast Frames Received/Transmitted:  The total number of Unicast frames 

received/transmitted on the transport stream. 
 

• Multicast Frames Received/Transmitted:  The total number of Multicast frames 
received/transmitted on the transport stream. 

 

 
Figure 4-2: Ethernet Monitor Main/Redundant 

 
Selecting the “SNMP Trap Destination” tab allows the User to add the IP address of the SNMP monitoring 
agent. This will inform the user of any traps that triggered. 
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• Add Trap Destination: Input for the IP address of the SNMP monitoring agent 
 

• Current Trap Destination: Displays the currently used IP address’ of the SNMP monitoring agent 
 

 
Figure 4-3: SNMP Trap Destination 

 

4.3. INPUT TO IP CONTROL 

Select the “+” option beside the “Input to IP” submenu to expand this view to see the numbered physical 
SDI input ports (6 or 12 dependant on your 3080IPG-HD model). These numbered inputs coincide with the 
same numbered SDI input ports on the 3080IPG-HD rear-plate. Open the desired SDI input by right 
clicking and selecting “View Configuration”, which will allow for IP output configuration for this SDI input 
stream. 
 

4.3.1. IP Output Control Tab 
 

 
Figure 4-4: Input to IP Redundancy Control  

 
• IP Tx Redundancy Mode: This feature allows the user to set which Tx Redundancy mode is active 

for the outgoing IP stream: 
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o Off – Allows both ports to simultaneously stream the same content with different destination 
IP addresses (when both ports are enabled) 

 
o Manual – Allows the user to select which port will stream the content 

 
o Revertive – If both ports are enabled, Main will be used to stream the content until a link 

loss occurs. The content will be streamed from the Redundant port until the link is returned 
to the Main port. The link restoration to the Main port will automatically switch the stream to 
transmit from Port 1  

 
o Non-Revertive – If both ports are enabled, Main will be used to stream the content until a 

link loss occurs. The content will be streamed from the Redundant port until a link failure 
occurs on the Redundant port and the link is restored on to the Main port without errors. 

 
• IP Tx Active Ethernet Port: Control to select which port will be used to stream content when the 

Redundancy Mode is set to Manual. 
 

• IP Tx Redundancy Port Loss Timeout: Sets the amount of time (in seconds) that will cause a 
port failover if the port status is lost. 
 

4.3.2. SDI Input Monitor Tab  

 
Figure 4-5: Misc. Monitor Tab 

 
• Presence: Displays if the SDI input is Locked (available) or Lost (unavailable) 

 
• Input Video Standard: Displays the Video standard of the incoming Stream 

 
• IP Tx Active Ethernet Port:  Displays the active port that is currently streaming content (valid 

when IPTx Redundancy mode is set to “on”) 
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4.3.3. Misc. Faults Tab  

 
Figure 4-6: Misc. Fault Tab 

 
• Input Presence Trap: Selecting this trap enables a notification if the input SDI stream is Lost. This 

notification will be sent to the IP address defined in the SNMP Trap Destination IP Address (see 
Fig. 4-3) 
 

4.3.4. Port Control Panel 
Each physical IP output port can stream one copy of the incoming SDI stream. The 3080IPG-HD has the 
ability to create a main and backup IP stream, which can be used as a fail over redundancy measure with 
equipment further down the network path. 
 

 
Figure 4-7: Input to IP Port Control 

 
• Enable: Control to enable or disable the Port output  

 
• Sources IP Address: Enter the source IP address associated with this stream. This address can 

be the physical IP address of your data port, or any other address that you may want to be 
encapsulated within the IP packets. 
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• Sources UDP Port (0 to 65535): Enter the source UDP port number for the IP address entered 
above. 

 
• Destination IP Address:  Enter the Unicast or a Multicast (Destination) IP address. Multicast 

addresses should be in the range of 224.0.0.0 through 239.255.255.255. 
 

• Destination UDP Port (0 to 65535):  Enter the destination UDP port number for the destination IP 
address entered above. 

 
• Type of Service (ToS): Enter the ToS value, if your network does not support ToS, use zero as 

default. 
 

• TTL: Use this slider to set the Time to Live (TTL) value.  Using the Multicast IP protocol, the TTL 
value indicates the scope or range in which a packet may be forwarded. By convention: 

 0 is restricted to the same host 
 1 is restricted to the same subnet 
 32 is restricted to the same site 
 64 is restricted to the same region 
 128 is restricted to the same continent 
 255 is unrestricted 

• RTP Mode: Use this drop down box to enable (On) or disable (Off) the use of RTP.  The use of 
RTP is recommended as it provides services such as time stamping, sequence numbering and 
delivery monitoring, which can be beneficial for real-time delivery systems.   

 
• TS Packets/ IP Frame: This field enables the user to enter the number of transport stream packets 

to be encapsulated per IP packet.   The range of packets per IP packet is from 1 to 7.  Long-length 
packets are undesirable due to the excessive impact from losing each IP packet.  Short packets 
cause a high overhead so a value chosen will be a compromise between these two factors.   

 
• TS Packets Size: Use this drop down box to set the size of the TS packet.  The size options 

include Auto, 204 bytes or 188 bytes.  
 

4.3.5. Monitor Tab 
The tab displays the output status of the IP streams configured in the previous section. The IP Packets 
Sent monitor will not change unless a valid SDI signal is present, and the output IP stream is “Enabled” 
with a correct destination IP address, and UDP port configuration. Using the auto refresh button can aid 
troubleshooting of the connectivity issues. The monitoring fields can be reset at any time by clicking on the 
“Clear Stats” button. There are no user configurable items on this page. This page is for information 
purposes only.  
 

 
Figure 4-8: Input to IP Monitoring  
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• IP Packets Sent: This field displays a counter for the packets being sent out of the port, from the 
specified stream on the port. 

 
• Clear Stats: The IP Packets Sent monitoring fields can be reset at any time by selecting this button. 

 
4.3.6. Input to IP Redundancy 
The SDI input signal is encapsulated to IP in a method where two copies are produced over two separate 
ports. The user can individually control the properties of these streams by using the “Port Control” tab (see 
Fig 4-7) to assign Multicast & Source IP addresses, as well as UDP Source and Destination Port value’s to 
each of the copies. By assigning the stream properties, the user is in full control of which streams are used 
to implement redundant measures within the system. Ensure the Evertz equipment used throughout the 
system supports automatic failover switching when using this method. 
 

SDI  Input 

TSM Lite 
Analyzer

Port 1
10 GigE 

SFP+ Cage

IP 
encapsulators

IP 
encapsulators

Multicast 1.1

 

Multicast 2.1 
Port 2

10 GigE
SFP+ Cage

 
 

Figure 4-9: Input to IP Port Redundancy Block Diagram 
 

4.4. IP TO OUTPUT CONTROL 

Select the “+” option beside the “IP to Output” submenu to expand this view to see the numbered physical 
SDI output ports (6 or 12 dependant on your 3080IPG-HD model). These numbered outputs coincide with 
the same numbered SDI output ports on the 3080IPG-HD rear-plate. Open the desired SDI output by right 
clicking and selecting “View Configuration”, which will allow for IP input configuration for this SDI output 
stream (see Fig. 4-10 & 4-11). 
 
 

4.4.1. Redundancy Control Tab 

• IP Rx Redundancy Mode: Use this feature to select which Redundancy mode the SDI output will 
use if redundancy is required 

 



EMX3/EMX6/3000FR/3700 MultiFrame Manual 
3080IPG-HD High Density IP Gateway 

Page - 18 Revision 1.0 CARD CONFIGURATION 

• IP Rx Force Active Ethernet Port: Sets the Ethernet port that will be used to stream the SDI 
output 

 

 
Figure 4-10: IP to Output Redundancy Control  

 

4.4.2.   Port Clarification 
For SDI DIN outputs 1-6:  
SFP Port 1 is defined as Main 
SFP Port 2 is defined as Redundant 
 
For SDI DIN outputs 7-12: 
SFP Port 3 is defined as Main 
SFP Port 4 is defined as Redundant 
 

4.4.3.   Port Control Tab 
Each physical IP port can subscribe to one IP stream at a single time per output din.  
This is managed by setting the desired Multicast address for the input IP streams on the Main and 
Redundant port.  
 
For each individual SDI output, the user can subscribe to one IP stream per port. This allows the SDI 
output to be driven from one of two sockets. 
 

 
Figure 4-11: IP to Output Port Control  
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• Enable: Enable or Disable the Input stream on the specific port  
 

• IP Address: Enter the destination IP address, the multicast address you want to receive. Ensure 
you enter the correct IP address and it is in the multicast address range of 224.0.0.0 through 
239.255.255.255   

 
• UDP Port: Enter the destination port number for the IP address entered above 

 
• IGMPv3 Mode: IGMP is the protocol used by IPv4 systems to report their IP multicast group 

memberships to neighbouring multicast routers. Version 3 of IGMP adds support for "source 
filtering", that is, the ability for a system to report interest in receiving packets *only* from specific 
source addresses, sent to a particular multicast address.  That information is be used by multicast 
routing protocols to avoid delivering multicast packets from specific sources to networks where 
there are no interested. Use this drop down menu to set the IGMPv3 mode to Include or Exclude 
Source address(es) defined. 

 
• IGMPv3 Source Select: This drop down menu list all the defined sources. Select the source 

number to display the IP address under “IGMPv3 Source”.  
 

• IGMPv3 Source: Enter the IP address for the source selected under “IGMPv3 Source Select”.  A 
maximum of 6 addresses could be defined per IP Stream 
 
 

4.4.4.   Monitor Tab 
The tab displays the Input status of the 10GigE IP Data Port. The status will not change unless a valid 
transport stream is detected (you may be required to refresh the status or select auto-refresh to view the 
change). Using the auto refresh button can aid troubleshooting of the connectivity issues. The monitoring 
fields can be reset at any time by clicking on the “Clear Stats” button.  
 
• IP Rx Active Ethernet Port: This monitor displays the active IP Port that is used for SDI output 

 
• IP Presence: This field displays whether the incoming transport stream is Present (Locked) or Not 

Present (Lost) 
 

• IP Packets Received: The total number of IP packets received from the transport stream 
 
• Clear Status: The Incoming IP monitoring fields can be reset at any time by selecting this button.  
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Figure 4-12: IP to Output Monitoring  

 

4.4.5. IP to Output Redundancy 
The IP input signal is de-encapsulated to an SDI output in a method where one of two possible IP input 
streams is used for SDI output. The user defines which IP streams will be used for de-encapsulation by 
entering the Multicast address of the desired streams in the “Port Control” Tab (see Fig 4-11). The 
methods of IP to Output Redundancy are as follows: 
 
• Manual 

o The user manually selects which Port from which the stream will be de-encapsulated and used as 
the SDI output. There is no automatic failover measure for this Redundancy Mode. 

 
• Revertive 

o The Main port will be used first as the IP input to receive the SDI over IP stream. When a failover 
measure is required (link loss/ UDP loss occurs) the Redundant Port will be used as the IP input to 
receive the SDI over IP content for the SDI output stream. Upon stream restoration without errors, 
the main port will be switched to as IP input for the SDI output stream. 

 
• Non-Revertive 

o The Main port will be used first as the IP input to receive the SDI over IP stream. When a failover 
measure is required (link loss/ UDP loss occurs) the Redundant Port will be used as the IP Input to 
receive the SDI over IP content for the SDI output stream. The SDI output will continue to use the 
Redundant Port as the IP Input until a failure occurs and the stream is restored on the Main port 
without errors. 
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Figure 4-13: IP to Output Redundancy Block Diagram 

 

4.5. DEVICE REDUNDANCY 

Device redundancy is a 1 to 1 backup scenario in which the functionality of a failing device is taken over 
by a backup device. This backup scenario is handled by VistaLINK® PRO in conjunction with Auto-
Response or IRM. 
In a normal situation the main 3080IPG-HD (the active device) as well as the backup  
(inactive device) process the SDI streams, VistaLINK® PRO monitors both devices. Streaming on the 
10GbE ports of the main device is activated and on the 10GE ports of the backup device is stopped. 
 
When VistaLINK® PRO detects a Device Operational Failure alarm on the active device or detects that the 
active 3080IPG-HD becomes non-responding; it will start a backup failover by running an auto response 
profile which set the active device to inactive and the inactive device to active.  
 
After a main-to-backup failover (Backup: main device becomes inactive and backup device active) and the 
alarm triggering the failover is cleared, a Backup-to-main failover (Restore: main device becomes active 
and backup device inactive) can be started manually or automatically. 
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Figure 4-14: Unit Redundancy Block Diagram 
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5. TROUBLESHOOTING 

5.1. UPDATING VLPRO SERVER JAR FILE  

Evertz products are constantly evolving and new features are often added. It is therefore important to 
update the JAR files in use to provide access to all the latest features or enhancements. It will also be 
necessary to add JAR files for new products. If your new product has not appeared even after waiting a 
few minutes for the Ethernet switch negotiation to complete, then it is possible that your JAR file may be 
old or missing. 
 
To perform a JAR update, ensure that all VistaLINK® PRO clients are closed (those clients which are not 
closed will automatically be disconnected as soon as the VistaLINK® PRO Server is restarted). Maximize 
the VistaLINK® PRO Server window from the Windows task bar, select Help> Apply Update> Product from 
the menu.  
 

 
Figure 6-1: VistaLINK® PRO Server  

 
A window will appear, as shown in Figure 5-2, navigate to the location of the new JAR file and double click 
to select the file. The window will automatically close and the update will be applied in the background.  
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Figure 6-2: VistaLINK® PRO – Applying JAR Updates 

 
You will be prompted to restart the server to enable the change to take effect. Apply as many JAR updates 
as required before restarting the server. 
 

 
 
 

 
NOTE: You may confirm that all updates have been successfully applied by selecting 
from the menu Tools>View>Show/Hide Product update log. 

 
From the menu, shutdown the server by selecting File>Shutdown Server. Now re-open the server, it is 
normal for the start-up to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VistaLINK® PRO Clients. As the Client restarts you will experience a short 
delay while the update is applied. A prompt will appear confirming that the updates have been applied. 
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